
1 

 

 

THẦY BÙI THANH LIÊM 2 
 

FreeForums-Tạo diễn đàn trực tuyến, chuyên nghiệp, miễn phí  

 
Khi nói đến việc sở hữu một diễn đàn cho riêng mình thì nhiều bạn cho rằng đó là một “ước mơ xa vời”, 

đấy là suy nghĩ của những năm trước đây. Nhưng hiện nay đã khác, các dịch vụ đáp ứng các nhu cầu này 

xuất hiện ngày càng nhiều, mà một đại diện đó là FreeForums.org. 

 

  
 

Không phải ngẫu nhiên mà dịch vụ FreeForums  được giới thiệu ở bài viết này, vì những lợi ích nó mang 

lại nhiều hơn đa số các dịch vụ cùng loại khác. Ngoài lợi ích rất dễ quản trị, không cần hiểu biết nhiều về 

các kiến thức lập trình thì còn có nhiều đặc tính hữu dụng khác không thể bỏ qua như: sử dụng công nghệ 

mới nhất để tối ưu máy chủ giúp diễn đàn hoạt động ổn định, có nhiều tính năng tùy chỉnh diễn đàn, khả 

năng bảo mật cao, được trang bị công cụ thống kê và theo dõi diễn đàn, luôn sao lưu dữ liệu hàng giờ giúp 

dữ liệu an toàn, có hơn trăm mẫu giao diện để bạn lựa chọn, dịch vụ hỗ trợ liên tục (24/7) và hoàn toàn 

miễn phí, .... Bây giờ, bạn có thể bắt tay vào việc khám phá và thiết kế diễn đàn bằng dịch vụ 

FreeForums. 

 

1. Đăng kí tài khoản. 

 

            Đầu tiên, bạn truy cập vào địa chỉ http://www.freeforums.org rồi nhấn vào nút Create a Free 

Forum. Trong cửa sổ Sign Up hiện ra, bạn cần khai báo đầy đủ và chính xác các thông tin yêu cầu: First 

Name-tên, Last Name-họ, Email Address-địa chỉ thư điện tử, Username-tên người dùng, Password-mật 

khẩu, nhập tên miền diễn đàn vào bên dưới dòng chữ Forum Domain (lower case, alphanumeric 

characters only), chẳng hạn: http://“thanhliem24”.freeforums.org. Riêng đối với mục Forum Category, 

bạn nhấn vào nút xổ xuống để chọn một chủ đề trong các lĩnh vực: Automotive, Business, Dating, Digital 

Photography, Education & Reference, Entertainment, Gamings, Sports, Technology,… Khi xong, bạn 

đánh dấu kiểm vào ô I have read and agree to the FreeForums Terms of Service để đồng ý với các điều 

khoản của dịch vụ, rồi nhấn Sign Up! hai lần. Quá trình đăng kí hoàn tất khi bạn đăng nhập vào tài khoản 

thư điện tử đã đăng kí để kích hoạt đường dẫn và xem lại tên miền. 

http://www.freeforums.org/
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2. Quản lí diễn đàn. 

 

            Sau khi kích hoạt tài khoản, bạn hãy nhập vào các ô Username và Password đã đăng kí trong mục 

Login.Register rồi nhấn Login. Lưu ý, để thuận tiện hơn cho lần đăng nhập sau bạn đánh dấu kiểm vào ô 

Log me on automatically each visit. Kế đến, bạn nhấn vào dòng chữ Administration Control Panel để 

đăng nhập vào bản quản trị diễn đàn. 

            Trên giao diện web, bạn nhìn thấy các nhóm tính năng được sắp xếp theo các thẻ Home, General, 

Appearance, Users & Groups và Upgrades. 

-Những thiết lập chung (General): 
+Board Settings: Giúp bạn điều chỉnh những thiết lập mặc định như: Forum Name-tên diễn đàn (không 

làm thay đổi tên miền mà bạn đã đăng kí), Forum Description-giới thiệu ngắn về diễn đàn, Forum 

Category-chỉ định lĩnh vực mà diễn đàn hướng đến, Date format-kiểu hiển thị ngày giờ, System timezone-

giờ khu vực. 

  

+Categories and Forums: Mục này rất quan trọng vì nó giúp bạn thêm hay bớt số lượng chủ đề, chuyên 

mục trên diễn đàn. Bạn nhập vào tên chủ đề (chuyên mục) mới và nhấn Add Forums, rồi quy định: Forum 

Type-kiểu diễn đàn, Parent Forum-chọn chuyên mục trực thuộc, Description-những chú thích về chuyên 

mục, Forum Status-trạng thái của chuyên mục, rồi nhấn Next. Ở cửa sổ kế tiếp, bạn tiến hành phân quyền 

truy cập vào chủ đề cho các nhóm đối tượng: Guests-khách, Registered users-thành viên, Global 

moderators-điều hành diễn đàn, Administrators-quản trị diễn đàn. Ngoài ra, bạn có thể sử dụng công cụ di 

chuyển lên xuống chuyên mục (biểu tượng hai mũi tên ngược chiều) để di chuyển vị trí của chúng. 
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+Mod Center: Bạn sử dụng tính năng này để kích hoạt hoặc tạm dừng hoạt động của các nút lệnh, hiển thị 

trạng thái truy cập của thành viên, tinh chỉnh kích thước ảnh, …trên diễn đàn. 

+Traffic Stats: Cung cấp thông tin đầy đủ và chi tiết về số lượng truy cập ở từng trang; hiển thị hệ điều 

hành, trình duyệt, độ phân giải màn hình và địa phương của khách đã truy cập; vẽ biểu đồ hình cột (hay 

biểu đồ diện tích) giúp so sánh số trang đã xem, số người truy cập, số lượt truy cập, ở các thứ trong tuần. 

-Thay đổi giao diện diễn đàn (Appearance): 

            +Choose a Style: Dịch vụ FreeForums đưa ra hơn 120 giao diện khác nhau để bạn lựa chọn, từ 

cách lựa chọn theo dãy màu sắc phía trên đến cách lựa chọn theo chủ đề Popular (các mẫu được yêu 

thích), Gaming hay All Styles (xem tất cả các mẫu). Nếu bạn thấy vừa ý với một mẫu nào đó thì nhấn 

Install sẽ có ngay kết quả. 

 

  

 

+Upload logo: Bạn nhấn vào nút Browse trong khung Upload new logo, rồi duyệt đến thư mục lưu trữ tập 

tin ảnh trên máy tính. Lưu ý, hình ảnh đại diện này được đặt ở giữa phía trên giao diện diễn đàn. 

            +Smilies: Giúp cho các thành viên có thể chèn các biểu tượng cảm xúc vào trong bài viết của 

mình. Ngoài những biểu tượng sẵn có, bạn nhấn nút Browse để thêm một số khác nếu cảm thấy chưa đầy 

đủ. 

 

-Quản lí nhóm và thành viên (User & Groups): 

 

            Với công cụ này, bạn sẽ tìm thấy những thông tin đầy đủ của một thành viên đã đăng kí trên diễn 

đàn. Và nếu đang dùng quyền quản trị thì bạn có thể thay đổi các thông tin, giới hạn quyền của thành viên 
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đó. Ngoài ra, bạn sử dụng công cụ Manage groups để quản lí các thành viên theo các nhóm đối tượng như 

đã giới thiệu ở trên. 

 

3. Một số lưu ý. 

 

            -Sau mỗi thay đổi ở Administration Control Panel, bạn phải nhấn Submit thì thiết lập mới ấy mới 

có hiệu lực. 

            -Một điểm còn hạn chế của FreeForums.org là chưa hỗ trợ tốt tiếng Việt có dấu, tức là khi nhập 

tiếng Việt với bảng mã Unicode vào tên chuyên mục thì văn bản hiển thị sẽ bị lỗi, còn đối với các ghi chú 

(Desciption) thì văn bản hiển thị tốt. 

            -Bạn có thể sử dụng dịch vụ Recovery Console để xóa bỏ diễn đàn đã tạo. Trong các thư điện tử 

FreeForums gửi đến, bạn tìm đến thư có chủ đề Your Recovery Console login để xem mật khẩu đăng nhập 

dịch vụ. Bây giờ, bạn sử dụng Username và Password đó đăng nhập vào trang Recovery Console 

(http://rc.freeforums.org), rồi nhấn nút Delete Forum ở phía trên. Sau khi chọn và nhấn nút Delete (nhấn 

Yes) thì dịch vụ sẽ gửi đến email đã đăng kí của bạn một thư xác thực với chủ đề FreeForums Forum 

Removal Confirmation. Và nếu không có gì thay đổi thì bạn hãy nhấn vào đường dẫn bên dưới để hoàn tất 

việc gỡ bỏ diễn đàn. 

 
 

BÙI THANH LIÊM 

 

3 bước đưa website lên mạng Internet không tốn tiền  

 
Trong thời đại bùng nổ thông tin thì việc tự tạo cho mình một trang web để học tập, chia sẻ kinh 

nghiệm,…là việc làm rất cần thiết. Do đó, nhiều bạn đã tự thiết cho mình một website bằng một số phần 

mềm như Microsoft FrontPage, Incomedia WebsiteX5, H&M StudioLine Web, Xara Web Designer,… 

  

Câu hỏi đặt ra là sau khi thiết kế xong làm sao đưa website đi vào hoạt động?. Hiện nay, có rất nhiều dịch 

vụ cung cấp tên miền và hosting có phí lẫn miễn phí phục vụ nhu cầu này. Nhưng trong giai đoạn đang 

tập làm website thì đa số bạn đã chọn cho mình các dịch vụ miễn phí, bởi vì không ai đầu tư cho những gì 

mà mình chưa nắm vững về nó. Bài viết sẽ giới thiệu đến các bạn ba bước đưa website lên Internet với các 

dịch vụ tên miền và hosting miễn phí. 

  

1) Đăng kí hosting. 

  

 Có rất nhiều dịch vụ cung cấp các hosting miễn phí nhưng xét về tính ổn định và không gian lưu trữ thì 

hosting 000webhost.com có lẽ là một lựa chọn tốt nhất. Khi đến với hosting, bạn sẽ được cung cấp một 

dung lượng lưu trữ trực tuyến là 1500MB, băng thông 100GB/tháng, một Custom Panel (cPanel),…và đặc 

biệt hơn là không có bất kì mẫu quảng cáo nào. 

  

http://rc.freeforums.org/
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            Trước hết, bạn truy cập vào website www.000webhost.com rồi nhấn nút Sign Up!. Ở cửa sổ Order 

Free Web Hosting, bạn cần đặt tên cho tên miền của mình dạng abc.com tại ô I want to host my own 

domain hoặc đặt tên miền phân cấp tại I will choose your free subdomain. Kế đến, bạn cần khai báo thông 

tin cá nhân và thông tin bảo mật tại các ô: Your name-tên bạn, Your email-địa chỉ email, Password-mật 

khẩu ít nhất 6 kí tự, Type password again-nhập lại mật khẩu, mã hiển thị (Enter the number you see in the 

image), rồi đánh dấu kiểm vào I agree to Terms of Service để đồng ý với các điều khoản của dịch vụ và 

nhấn Create My Account.   

 

http://www.000webhost.com/
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            Khi đăng kí thành công thì 24 giờ sau, bạn đăng nhập vào hộp thư của mình và tìm thư có nội 

dung Account „tên miền‟ is ready!. Trong thư này, bạn cần lưu ý các thông số FTP Hostname, FTP 

Username, FTP Password ở mục File Upload Details, bởi vì nó sẽ được sử dụng vào việc đưa dữ liệu lên 

Internet. Ngoài ra, sau khi tài khoản đã hoạt động thì bạn đăng nhập vào CPanel sẽ tìm thấy được rất 

nhiều thông tin về tài khoản của mình tại View Account Details và tên máy chủ của domain 

(ns01.000webhost.com và ns02.000webhost.com). 

 

2) Đăng kí tên miền. 

 

            Cũng giống với hosting, các dịch vụ cung cấp tên miền cũng có rất nhiều nhưng ở bài viết này sẽ 

giới thiệu về dịch vụ co.cc (hay đầy đủ hơn là www.co.cc), đây. Điểm dễ nhận thấy nhất ở dịch vụ này là 

tên miền sau khi tạo ra rất dễ nhớ („tenweb‟.co.cc), cộng thêm khi tên miền được tạo ra thì bạn sẽ có toàn 

quyền quản lí DNS (Domain Name System) và các Zone Record nên có thể sử dụng tính năng này để trỏ 

(point) đến hosting mà bạn đã đăng kí tại 000webhost.com. 

            Đầu tiên, bạn truy cập vào website www.co.cc và chuyển giao diện web về ngôn ngữ Việt để dễ sử 

dụng bằng cách nhấn vào nút xổ xuống tại mục Change Language > tìm đến Tiếng Việt. 

http://www.co.cc/
http://www.co.cc/
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Bạn nhấn vào Tạo một tài khoản ngay bây giờ > điền đầy đủ những thông tin cá nhân như Họ, Tên, Địa 

chỉ email, Giới tính, Sinh nhật, Mật khẩu và Xác minh từ. Ngoài ra, bạn cần điền đầy đủ những thông tin 

có đánh dấu tại mục Account Information như Địa chỉ đường phố, Thành phố/Thị xã, Bang/Tỉnh, Quốc 

gia/Khu vực, Điện thoại (không cần khai báo chính xác). Sau đó, bạn đánh dấu kiểm vào ô Tôi chấp nhận 

các Điều khoản Dịch vụ > nhấn nút Tạo một tài khoản ngay bây giờ . Kế đến, bạn bước vào của sổ quản lí 

tên miền (Manage Domain) > nhấn Cần một tên miền mới > nhập vào tên miền muốn tạo và nhấn nút 

Kiểm tra tính sẵn sàng > nhấn nút Tiếp tục đăng kí. Trong cửa sổ kế tiếp, bạn nhập vào ô Tên người dùng 

(Email) địa chỉ mail, Mật khẩu, xác minh từ vào ô bên cạnh  và nhấn Đăng nhập. 

  

 
 

Bạn có thể cài đặt Name Server hướng đến máy chủ được cung cấp bởi hosting 000webhost.com bằng 

cách nhập vào hai ô Name Server 1 và Name Server 2, nhấn Cài đặt  để hoàn tất. Việc còn lại là bạn phải 

chờ một khoảng thời gian để thay đổi có hiệu lực (thông thường khoảng 8 giờ đồng hồ nhưng đôi khi mất 

đến 48 giờ). 

  

http://www.000webhost.com/


8 

 

 
 

Lưu ý, đồng thời với việc trỏ đến hosting thì bạn cần vào Cpanel > tìm đến mục Domains > chọn Parked 

Domains > nhập tên miền mà bạn đăng kí ở trên vào ô Park > nhấn Park Domain. 

  

3) Đưa dữ liệu lên hosting 

  

  Nếu bạn sử dụng phần mềm Incomedia WebsiteX5 hoặc các phần mềm tương đương khác để tạo website 

thì việc đưa dữ liệu lên Internet không cần dùng thêm một phần mềm nào khác, bởi vì bản thân các 

chương trình này đã tích hợp sẵn tính năng đó. Đối với phần mềm Incomedia Website X5, bạn chọn 

Upload to the Internet rồi điền vào những thông tin về tài khoản FTP: FTP Address (chẳng hạn 

ftp.thanhliem24.com hay địa chỉ IP), User name (tên tài khoản), Password (mật khẩu), Initial Directory 

(đường dẫn đến thư mục), rồi nhấn Next. 
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            Nếu bạn sử dụng Microsoft FrontPage hoặc các phần mềm không có tính năng upload dữ liệu thì 

có thể sử dụng phần mềm FileZilla 3.2, đây là một phần mềm miễn phí giúp tải dữ liệu lên hosting theo 

giao thức FTP, nó có dung lượng cài đặt nhỏ gọn chỉ với 3,73MB, bạn có thể tải tại địa chỉ: 

http://www.mediafire.com/?yimyzchzimo 

  

Sau khi cài đặt, bạn vào giao diện của chương trình nhập các thông số về Host-địa chỉ IP của website, 

Username-tên tài khoản, Password-mật khẩu, rồi nhấn Qickconnect để chương trình kiểm tra kết nối với 

máy chủ. Khi kết nối thành công, bạn sẽ nhận được thông báo Directory listing successful và khi đó việc 

upload dữ liệu lên máy chủ rất dễ dàng giống như đang thao tác trên ổ cứng. 

  

http://www.mediafire.com/?yimyzchzimo
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            Hy vọng, sau khi tham khảo bài viết này thì các bạn mới làm quen với lĩnh vực webdesign sẽ có 

những bài tập đầy lí thú với những dịch vụ miễn phí nêu trên và cũng có dịp giới thiệu với bạn bè, đồng 

nghiệp về website “tự tay” của mình. Nếu có vấn đề trao đổi gì về bài viết thì bạn có thể gửi bình luận để 

mọi người có thể cùng chia sẻ. 

  

Bùi Thanh Liêm 

 

9 cách chỉnh sửa hệ thống để Windows chạy nhanh hơn  

 
Sau một thời gian hoạt động, máy tính của bạn sẽ trở nên rùa bò hơn. Nếu không có điều kiện nâng cấp hệ 

thống thì bạn có thể thực hiện 9 phương pháp sau để chữa hệ hệ thống nhằm tối ưu cho máy của bạn một 

cách dễ dàng mà không cần một phần mềm tăng tốc nào cả 

Máy khởi động chậm 

Có nhiều lý do khiến cho Windows khởi động chậm chạp mà nguyên nhân chủ yếu là do hệ thống tải quá 

nhiều ứng dụng trong quá trình khởi động. Để giảm bớt gánh nặng này, bạn vào menu Start, chọn Run và 

gõ vào đây dòng lệnh msconfig rồi nhấn Enter. 
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Tại cửa sổ hiện ra, bạn tìm đến tab Startup, đánh dấu vào những tùy chọn cho phép khởi động cùng 

Windows, nếu tất cả các ứng dụng đều không quan trọng thì bạn có thể nhấn nút Disable All cho nhanh. 

Xong xuôi nhấn OK để xác nhận việc thiết đặt. 

Ngoài ra bạn có thể sử dụng một phần mềm chuyên gia quản lý việc này là Startup Delayer sẽ giúp bạn 

thiết lập dễ dàng hơn. Điểm đặc biệt của chương trình này là nó có thể cho phép người dùng giới hạn thời 

gian khởi động cùng Windows của một ứng dụng nào đó vào một thời điểm thích hợp sau khi máy đã 

khởi động xong một thời gian. Bạn có thể tải phần mềm này về tại địa chỉ http://tinyurl.com/b8ypj, tương 

thích Windows 98/ME/2000/XP/Vista   

Tăng tốc truy cập menu Start 

Một phần nguyên nhân khiến hệ thống khởi động chậm là do menu Start xuất hiện chậm. Tưởng rằng điều 

chỉnh cái này khó khăn nhưng bạn hoàn toàn thực hiện việc này dễ dàng trong Registry Editor. Cách thực 

hiện như sau: 

Vào Start, chọn Run và gõ vào đây dòng lện Regedit, nhấn Enter. Tại cửa sổ Registry Editor bạn tìm đến 

nhánh HKEY_CURRENT_USER\Control Panel\Desktop, tìm mục MenuShowDelay và nhấp đúp vào nó 

thay thế giá trị về số 0 (số mặc định là 400) rồi nhấn OK để xác lập việc thay đổi. 

  

 
 

Menu chuột phải khởi động chậm 

Nếu mỗi lần click chuột vào menu chuột phải bạn thấy tốc độ xử lý của nó chậm mà nguyên nhân chủ yếu 

là do quá nhiều ứng dụng xuất hiện trong nó thì bạn có thể sử dụng đến công cụ có tên gọi đơn giản là 

mmm. Phần mềm miễn phí, có thể tải về tại địa chỉ http://hace-software.com/mmm.shtml, phần mềm sẽ 

giúp bạn đơn giản hóa menu chuột phải của bạn bằng cách loại bỏ bớt những thức rườm rà để việc xử lý 

nhanh hơn. 

  

http://tinyurl.com/b8ypj
http://hace-software.com/mmm.shtml
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Menu Send to chậm chạp 

 

Send to được xem là công cụ gần gũi với khá nhiều người, với công cụ này bạn có thể dễ dàng gửi một 

file, một biểu tượng,... nào đó ra ngoài desktop, thiết bị lưu trữ,... Tuy nhiên nếu vì một lý do nào đó làm 

cho thao tác này chậm chạp do có quá nhiều ứng dụng không cần phải gửi đến thì bạn có thể làm theo 

cách sau: vào trình đơn Start, chọn Run và gõ vào đây dòng lệnh sendto để xóa bớt những thứ không cần 

thiết trong trình đơn send to đó. 

Công cụ Defragmentation tỏ ra chậm chạp 

Công cụ Defragmentation sẽ giúp bạn thực hiện các thao tác chống phân mảnh ổ cứng làm tốc độ truy 

xuất của nó trở nên nhanh hơn. Thế nhưng công cụ sẵn có của Windows cho tốc độ khá chậm chạp, thay 

vào đó bạn có thể sử dụng công cụ Defraggler (tải về tại http://www.defraggler.com/), đây là công cụ 

được xem là tốt nhất hiện nay có thể thay thế cho tính năng vốn đã bị mọi người lơ qua trong Windows. 

Cửa sổ làm việc xuất hiện chậm chạp 

Nếu cửa sổ My Computer xuất hiện chậm chạp bạn có thể thực hiện như sau: Vào Windows Explorer (có 

thể nhấn tổ hợp phím Windows+E). Tại cửa sổ làm việc vào menu Tools, chọn Folder Options, chọn 

View và bỏ chọn trước mục Automatically search for network folders and printers 

Gỡ bỏ bớt các ứng dụng thừa 

Một trong những nguyên nhân làm cho hệ thống chậm chạp cũng là do quá nhiều ứng dụng cài vào máy 

không cần thiết. Do đó nếu bạn cảm thấy thừa thãi bạn có thể sử dụng công cụ gỡ bỏ phần mềm chuyên 

dụng có thể thay thế công cụ Add/Removed của Windows nhẹ nhàng và miễn phí như Ccleaner (tải về tại 

http://www.ccleaner.com/) hay MyUninstaller (tải về tại http://www.nirsoft.net/utils/myuninst.html) 

Tăng tốc độ xử lý khi kết thúc 

Nếu muốn quá trình kết thúc một ứng dụng nào đó được nhanh hơn bạn có thể can thiệp vào registry để 

chỉnh sửa. Cách thực hiện như sau: và Start, chọn Run và gõ vào dòng lệnh Regedit. Tại cửa sổ Registry 

Editor bạn tìm đến nhánh HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\ và thay đổi về 

giá trị là 1000. 

Vô hiệu hóa bớt một số ứng dụng không cần thiết trong quá trình khởi động 

  

http://www.defraggler.com/
http://www.ccleaner.com/
http://www.nirsoft.net/utils/myuninst.html


13 

 

 
 

Để thực hiện bạn vào Control Panel, chọn Advanced, chọn Performance và click chuột vào biểu tượng 

Adjust for best performance, xong nhấn OK để chấp nhận. Với lựa chọn này tốc độ khởi động của 

Windows sẽ được cải thiện thêm đôi chút. 

Một số lời khuyên quý giá: 

+ Luôn luôn giữ cho máy tính sạch sẽ, bỏ các file/ thư mục rỗng không cần thiết. Có thể sử dụng công cụ 

Ccleaner (giới thiệu ở trên) để thực hiện việc này 

+ Không cài đặt những phần mềm thừa mà chỉ cần những phần mềm quan trọng nhất cần dùng phục vụ 

cho mình. 

+ Giữ các chương trình có thể khởi động trên thanh hệ thống (Tray) để truy xuất khi cần thiết, giảm bớt 

các chương trình xuất hiện khi khởi động Windows 

Theo XHTT Online 

 

Driver Genius Professional – Giải pháp quản lý toàn diện các 

trình điều khiển máy tính  

 
Chắc hẳn bạn đã ít nhất từng một lần cảm thấy khó chịu khi cài đặt lại hệ điều hành mà Windows không 

chịu nhận dạng hết, nhận dạng không đúng các trình điều khiển (driver) trên máy tính dẫn đến các thiết bị 

đó hoạt động ổn địn

lý do khiến nhiều bạn cảm thấy e ngại không dám cài đặt lại Windows dù 

rằng việc cài đặt lại hệ điều hành trên máy tính là điều cần nên làm để refresh lại máy sau quá trình sử 

dụng lâu ngày. 

  

Từ nhu cầu đó, trong số XHTT Online này, tác giả xin giới thiệu cùng bạn đọc một công cụ, một giải pháp 

quản lý toàn diện các trình điều khiển máy tính, đó là Driver Genius Professional  (phiên bản 9.0). Với 

công cụ Driver Genius Professional (DGP) không chỉ đơn thuần là giải pháp sao lưu & phục hồi trình điều 

khiển máy tính sau khi cài đặt lại hệ điều hành hoặc một trình driver nào đó bị lỗi mà còn một công cụ 
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quản lý, tìm kiếm & cập nhật những driver mới nhất nhằm tăng hiệu suất hoạt động cho các trình điều 

khiển trên máy tính của bạn. 

  

Một số tính năng chính của phần mềm: 

  

- Sao lưu tất cả hoặc một trình điều khiển bất kì cho việc backup. 

- Phục hồi tất cả hoặc một trình điều khiển nào đó bị lỗi 

- Gỡ bỏ trình điều khiển bị lỗi, version cũ 

- Nhận diện & cập nhật dirver mới nhất 

- Tiện ích quản lý kết nối & tải về các trình điều khiển máy tính 

  

 
 

GỢI Ý KHAI THÁC 

  

Khởi động chương trình lần đầu tiên, chương trình sẽ yêu cầu bạn cho phép thực hiện thao tác Scan tất cả 

driver trên máy tính và cập nhật dữ liệu mới nhất cho Driver Genius Professional (cần có kết nối Internet). 

Hai công việc trên bạn nên thực hiện theo sự hướng dẫn của chương trình, bởi nó sẽ mang lợi ích cho bạn: 

Một là việc Scan tất cả driver để chương trình có thể nhận diện giúp bạn có driver nào cần cập nhật phiên 

bản mới hay không và đưa ra khuyến nghị nâng cấp cho bạn; hai là việc update cho công cụ Driver 

Genius Professional để chương trình có những dữ liệu mới nhất hoạt động chính xác & hiệu quả hơn. 

  

  

1. Sao lưu & phục hồi trình điều khiển  

 

  

Để sao lưu trình điều khiển, bạn nhấp vào tab Back Up Driver trên giao diện chính của chương trình, lúc 

này chương trình sẽ hiển thị tất cả driver đang được sử dụng trên máy tính của bạn. Mặc định là tất cả 

driver sẽ được backup, tuy nhiên nếu bạn nhận thấy driver không cần sao lưu thì bạn bỏ dấu check trước 

tên của trình điều khiển đó. Nhấn Next, chọn loại file backup trong mục Select the backup type, DGP hỗ 

trợ xuất ra 3 loại định dạng: tập tin nén (ZIP Archive), tập tin tự động giải nén (Self-extractor Archive), 

tập tin tự động thực thi (Auto-Installer Archive).  
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Trong trường hợp này tác giả khuyến cáo các bạn nên chọn loại backup là file Auto-Installer Archive sẽ 

nhanh hơn vì sau khi bạn cài điều hành, bạn có thể chạy file đó để phục hồi ngay driver mà không cần đến 

phần mềm. Hoặc nếu có bạn ý định backup trình điều khiển nào đó để install trên nhiều máy tính có cùng 

cấu hình thì việc này sẽ nhanh hơn và tiết kiệm thời gian. Sau cùng bạn chọn nơi lưu trữ file backup tại 

mục Choose a place to save your driver backup files và lưu ý bạn không nên sao lưu trên phân vùng đang 

chứa hệ điều hành vì lẽ rất đơn giản là khi cài đặt lại windows tất cả dữ liệu trên phân vùng đó sẽ bị xóa 

sạch. Nhấn Next để thực hiện sao lưu.   
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Bạn vừa mới cài đặt lại hệ điều hành, chỉ với một cú click chuột tại tab Retore Drivers thì mọi thứ driver 

sẽ được phục hồi như hệ thống ban đầu và bạn có thể sử dụng ngay mà không mất nhiều thời gian như 

trước. Thao tác phục hồi thì khá dễ dàng, bạn chỉ việc chọn Restore drivers from previous backup (phục 

hồi driver từ lần sao lưu trước) hoặc Browse my computer for driver backups (phục hồi từ file nguồn 

backup lưu trữ trên máy tính) -> chọn File từ mục Select a source for restoring drivers và duyệt đến thư 

mục lưu trữ - Choose the place where you have saved the backup file. Nhấn Next để phục hồi.  

  

  

 
 

  

Riêng với trường hợp bạn chọn loại sao lưu là file Auto-Installer Archive, thì bạn chỉ việc nhấp đúp vào 

file sao lưu đó để thực thi phục hồi nhanh mà không cần dùng đến phần mềm Driver Genius Professional. 

Điều này rất hữu ích khi bạn muốn chia sẻ driver hiện có trên máy của mình cho người khác có cùng loại 

thiết bị.  

  



17 

 

 
2. Gỡ bỏ trình điều khiển bị lỗi, version cũ  

 

  

Để gỡ bỏ một trình điều khiển bất kì có thể gây hại cho hệ thống, bạn vào tab Uninstall Drivers, đánh dấu 

check một vào trình điều khiển nào đó mà bạn muốn gỡ bỏ trong cửa sổ danh sách các trình điều khiển 

hiện có trên máy tính, nhấn Next để thực hiện.  

 

 
 

3. Nhận diện & cập nhật dirver mới nhất cho máy tính   

  

Tự động tìm kiếm và nhận diện những trình điều khiển nào trên máy tính cần cập nhật phiên bản mới...là 

một tính năng đi kèm rất hữu ích cho người dùng. Không dừng lại ở đó, DGP còn hỗ trợ thêm công cụ tự 

động kết nối tải driver với kho thư viện driver (với hơn 300.000 driver được hỗ trợ) và sau khi tải về 

chương trình còn hỗ trợ cả việc cài đặt sao cho đơn giản nhất với người dùng. 
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Bạn vào mục Update Driver, chọn loại hệ điều hành mà bạn đang dùng, chương trình sẽ tự động quét tất 

cả driver và đưa ra khuyến cáo danh sách các driver cần cập nhật, nhấn Next. 

 
 

  

Lúc này chương trình sẽ chuyển màn hình quản lý việc tải driver và cài đặt driver. Để tải về, bạn không 

cần phải thao tác nhiều bởi chương trình sẽ tự động kết nối lên kho driver trên internet và tiến hành tự 

động tải driver về theo lệnh mà bạn nhấp chọn và nhấn Download (hoặc Download all để tài về toàn bộ). 

Sau khi tải xong, nhấp chọn vào driver nào mà bạn muốn cập nhật mới cho trình điều khiển hiện có trên 

máy tính-> nhấn Install để cài đặt. 

 

 
 

Tương thích với mọi Windows, dung lượng 6.99 MB. Tải về dùng thử tại địa chỉ:  

http://www.avanquest.com/USA/software/driver-genius-professional-9-124897 hoặc sử dụng phiên bản 

đầy đủ tại http://mega.1280.com/file/VNXAMBNL/ 

http://www.avanquest.com/USA/software/driver-genius-professional-9-124897
http://mega.1280.com/file/VNXAMBNL/
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Theo XHTT Online 
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Nguồn TVTC 

 

Bàn luận đôi điều về đĩa Hiren boot CD 10  

 
Nếu Hiren boot CD  từ lâu được coi như bửu bối cứu hộ không thể nào thiếu được của giới vọc máy tính 

nước ta nhưng ở nước ngoài, họ không coi bao giờ coi trọng đĩa này,. Trái lại, họ còn  coi đây là một thứ 

warez rác rưởi, không đáng lưu tâm và không nên bàn đến,. Tại sao lại như vậy? 

 

 Khi nào bạn có dịp vào các trang web nước ngoài có uy tín về các đĩa cứu hộ như 

http://www.911cd.net/forums; http://www.msfn.org/..chớ bao giờ khen Hiren boot CD một tiếng, hay hỏi, 

hoặc đề cập gì đến anh chàng này nhé.. 

 
Bạn chỉ cần thêm chữ Hiren trong  bài viết, hay chú thích nào đó của bạn, ai nấy trong diễn đàn sẽ nhìn 

bạn bằng cặp mắt thiếu thiện cảm, phê bình bạn sán ván. Đồng thời họ cũng  góp ý  cho bạn biết  thêm là 

không bao giờ nên đề cập gì đến cái warez. ấy.  

  

http://www.911cd.net/forums
http://www.msfn.org/
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Lý do chính, ở nước ngoài, họ rất  tôn trọng bản quyền tối đa nên coi Hiren là một thứ Warez vi phạm 

nặng với gần cả trăm phần mềm trong ấy toàn là những thứ (non licensed),  nên không một ai ưa anh này 

cũng vì thế. 

 

Điều đáng nói ở phiên bản mới nhất 10 này,  tác giả  càng ngày càng cải tiến vượt bậc, có cả nối mạng 

được ngay trên CD và còn có thêm một MiniXP tuyệt vời. Nhưng do tác giả vẫn còn thích ôm đồm quá 

nhiều thứ không cần thiết cho lắm nên file ISO của nó (bản 10 đã lên đến gần 200MB thay vì chỉ 70MB 

như tcac bản cũ trước đây. 

 

I)  Có thể cài Hiren được ở mọi nơi: 

 

1) Bạn muốn có Hiren 10 ngay trong ổ cứng  cùng với XP?  

Hãy mở link này làm theo hướng dẫn: http://forum.kaspersky.vn/showthread.php?t=11269  

Điều này sẽ rất tiện khi cần xoá những file, thư mục lì lợm trong XP (ổ C máy tính); hay cần làm ghost 

phục hồi với ghost 32 trong Mini XP (sẽ không còn bị ngưng ngang giữa chừng như khi chạy Ghost.exe 

trong DOS), hoặc chép file vẫn tốt không còn bị những lỗi CRC khó hiểu trong máy..   

 

2) Cài  Hiren 10 vào cây viết USB càng tiện, để dành khi cần cứu hộ? Cũng đơn giản với việc dùng 

Google search (Cài Hiren vào USB) hay xem lại bài viết trước đây của bạn Nguyên trong XHTT. Có sẵn 

Hiren trong USB sẽ quá tốt mỗi khi bạn cần phục hồi  lại phân vùng  C bị  trục trặc, diệt virus quá  tốt do 

cập nhật được các virus mới nhất. Điều này sẽ hoàn toàn khác với khi dùng Hiren trong CD: sẽ không cập 

nhật thêm được do tính chất read only( chỉ đọc không thay đổi gì được).. Ngoại trừ bạn phải dùng đĩa  

CDRW xoá để làm lại đĩa này nhiều lần để cập nhật thêm virus mới. . 

 

Cần lưu ý thêm với các newbie, là giờ đây cách đưa Hiren 10 vào USB kể  từ phiên bản 9.5 trở đi hoàn 

toàn khác với các phiên bản trước chỉ dùng đĩa mềm làm file boot vào DOS. Phiên bản mới 10  dùng 

GrubDOS để cho chọn boot vào 1 trong 2 nơi, ngay ở menu khởi động, là DOS (công cụ cũ) hoặc MiniXP 

(file boot riêng bằng file hbc10.bin). 

 

3) Làm Hiren 10 boot cùng nhiều thứ khác cùng trong 1 đĩa CD\DVD hơi khó một tí với newbie  nhưng 

http://forum.kaspersky.vn/showthread.php?t=11269
http://xahoithongtin.com.vn/9630p0c252/cai-hiren-bootcd-moi-nhat-85-vao-o-cung-de-cuu-ho.htm
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nếu bạn rành BCDW 201, Easy boot CD thì lại không gặp chút khó khăn nào cả. 

 

Với  việc dùng BCDW 2.01, bạn chỉ cần chỉnh sửa file BCDW.ini và  chỉ đúng đường dẫn vào file boot 

hbc10.bin, hay dùng nguyên file ISO Hiren chỉ vào nơi đã lưu file ISO chọn để boot. 

 

Lưu ý, trong BCDW nếu bạn dùng cả 2  file ISO để chung vào CD nhưng lại  có thư mục  gốc tên giống 

nhau, sẽ  không được như là XPE và cài XP: Lúc  ấy, bạn  phải đổi tên  thư mục I386 của XP thành 

WNPE.      

 

II) Nhưng cái hay, cải tiến mới nhất của Hiren boot CD 10: 

 

Nếu trên mạng có rất nhiều link giúp tải về được Hiren 10, cũng như giới thiệu  về rất nhiều công cụ DOS 

của Hiren nhưng lại không có bất cứ website nào chỉ rõ cách dùng sao, là tốt nhất với Mini XP.. 

 

1) Nên sử dụng tối đa MiniXP có sẵn trong CD Hiren10 vì rất  tiện dụng cho bạn  do tính chất  khởi động 

khá nhanh, làm việc cũng thật nhanh, ít lỗi: không còn chậm chạp như là các công cụ  DOS  có trong 

Hiren, . 

 

Đặc biệt, những công cụ nào có thể chạy ngay trong Mini XP như là Ghost 32 bit  rất  thường báo lỗi do 

thiếu bộ nhớ.  Do vậy, nếu muốn MniniXP này làm việc tốt, bạn phải thay đổi lại Virtual memory (bộ nhớ 

ảo) cho MiniXP chỉ cần 1000MB (để ở ổ  D) thay 0 MB, thì tất cả sẽ hoạt động tốt  thôi . 

 

Khi thay đổi xong bộ nhớ ảo này, các ứng dụng di động (portable) nào đã chạy trong XP, sẽ vẫn  tốt trong 

Mini XP này như là Firefox, Partition magic portable, .. .  

 

Phần mini Win98 trong Hiren bạn không nên dùng nữa vì hay  thiếu bộ nhớ và không chỉnh được như 

MiniXP nên không có phần mềm này chạy tốt được cả. 

 

2) Hiren boot CD10 giờ đây có thể kết nối mạng quá tốt, ngay trong đĩa CD Hiren miễn là khi máy tính có 

card mạng. Bạn có thể duyệt các web nước ngoài bằng trình duyệt Opera có sẵn trong Hiren nhưng chữ 

Việt chưa thể hiện thật đúng với các trang web VN.  

 

Bạn nên nhập Favorites quen thuộc từ ổ C(có WinXP) vào lại Opera trong Hiren 10. Bạn cũng có thể 

dùng thêm các trình duyệt web  khác như Crazy browser 30,Green browser 3.6 có trong ổ C (cứ click đôi 

trong  trình duyệt  web ấy) là chạy trong Hiren được thôi 

 

3) Kết nối công cụ USB(cây viết ổ cứng) quá tốt  trong Mini XP, cứ cắm vào cổng USB là nó tự động 

hiện ra ngay. 

 

III) Những điều trong Hiren cần cải tiến thêm: 

 

1) Những công cụ trong DOS còn quá nhiều trong Hiren 10, nưng  các công cụ này trong nhiều năm bạn  

cũng không hề dùng đến: Riêng với từng nhóm công cụ, cũng vẫn là quá thừa: Nếu cần sao lưu, phục hồi 

phân vùng, chỉ cần có Ghost và  Acronis là đủ; làm phân vùng 2  anh  Partition magic, Acronis là quá đủ, 

ngay cả nhóm diệt virus cũng thế.. 

 

Theo ý kiến riêng tôi, mỗi nhóm công cụ chỉ cần có 1, 2 cái là quá  đủ mà không cần quá nhiều thứ đến 

như vậy. Chính việc này mới làm Hiren vi phạm bản quyền càng nghiêm trong hơn, hoàn toàn không ích 

gì,   Người dùng sẽ không bao giờ dùng hết hàng trăm công cụ trong DOS vá điều này còn khiến nhiều 

người khác  chính qui, càng ghét cay ghét đắng thêm đĩa Hiren boot 10 này nữa..     

 

2) Hiren còn thêm  tật xấu,  là cứ hỏi đi hỏi lại nhiều câu thừa thãi, hoàn toàn không cần thiết. Điều này 

chỉ khiến bạn mỗi khi cần vào ngay nơi cần thiết,  lại quá chậm: như làm Ghost trong DOS. 
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Theo tôi những gì bạn làm được trong Mini XP hãy dùng ngay trong đấy, sẽ  tốt và nhanh hơn ít lỗi hơn 

như Ghost 32 bit và Partition magic (dùng bản Portable để trong ổ cứng) 

 

3)Kết nối qua USB trong DOS của Hiren còn quá dở, rất  hay báo lỗi, không kết nối USB được(không đọc 

file trong USB được). Nếu bạn dùng MiniXP thì kết nối quá dễ, cứ  cắm vào cổng USB , nó nhận ngay 

công cụ USB  ấy không chút gì khó khăn. 

 

IV) So sánh Hiren với một vài đĩa CD cứu hộ khác: 

 

1) Đĩa  BartPE kết nối mạng ( có bài cũ trong XHTT đã  đề cập): hay hơn nhiều vì cũng kết nối mạng, 

nhưng lại có thể đánh văn bản tiếng Việt, xem trang web tiếng Việt. Trái lại,  MinXP (Hiren) không sao 

sánh kịp bằng, lại không thể có sẵn Partition magic 32 bit để  dùng ngay. 

 

2) Đĩa XPE đầy đủ hơn nhiều nhưng thời gian boot còn chậm do phải duyệt xong khá nhiều driver phần 

cứng). Đĩa này  khó làm hơn do phải tự làm qua nhiều bước cho riêng máy mình nhưng ngoài chuyện kết 

nối mạng có cả wireless, còn nghe nhạc, xem phim, ghi hình , hoặc điều khiển máy in  đều được ngay trên 

XPE CD. 

 

3) Đĩa  Win Seven live CD: không kết nối mạng được, khởi động khá nhanh sau vài giây, nhưng làm 

ghost 32 bit quá nhanh: nếu cần phục hồi từ file ghost trong ổ cứng chỉ sau vài phút. 

 

4) Đĩa Vista  CD portable dỡ nhất  vì không kết nối mạng, không đánh văn bản gì được 

 

5) Nếu các bạn nào đang xài Linux (Fedora) boot disk có thể bổ sung thêm  kinh nghiệm riêng của mình 

liệu anh chàng có hay hơn Hiren 10 ở bất cứ điểm nào không? 

 

Theo XHTT Online 

TẠO WEBSITE TRỰC TUYẾN, MIỄN PHÍ VỚI OFFICELIVE 

CỦA MICROSOFT  

 
Có lẻ Microsoft không còn xạ lạ đối với ai đã từng sử dụng máy tính, và hiện nay Microsoft không dừng 

lại ở các dịch vụ văn phòng “offline” mà còn vươn xa vào lĩnh vực dịch vụ văn phòng trực tuyến để đáp 

ứng người dùng mọi lúc mọi nơi, đó là dịch vụ Office Live. Với những kinh nghiệm như thế, khi kể đến 

các ứng dụng trực tuyến của Microsoft là bạn sẽ nghĩ ngay nó cũng rất dễ sử dụng giống như ta đang sử 

dụng Word hàng ngày vậy. Một trong những dịch vụ mà người dùng cần đến nhất trong thời đại Web là 

dịch vụ tạo Website trực tuyến và miễn phí của Office Live. 
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Khi đến với dịch vụ tạo Website của Office Live, bạn sẽ được cung cấp miễn phí một dung lượng lưu trữ 

được xem là khá lớn với người dùng phổ thông là 500MB (gấp năm lần mà Google Sites cung cấp cho các 

Website được thiết kế tại đây). Không những vậy, bạn sẽ nhanh chóng tạo cho mình một trang Web mà 

không gặp phải một khó khăn gì, bởi vì chắc hẳn ai sử dụng máy tính cũng đã dùng qua Microsoft Office. 

Website được bạn tạo ra từ dịch vụ này cũng mang đầy phong cách chuyên nghiệp không thu kém gì với 

một Website được lập trình bằng HTML cả. Bây giờ, chúng ta sẽ bắt tay vào việc thiết kế Website bằng 

bộ ứng dụng trực tuyến Office Live: 

 

1) Đăng ký trang Web: 

 

            Đầu tiên, bạn hãy truy cập vào trang Web: http://www.officelive.com và quan sát tìm đến mục 

Build a Free Website rồi nhấn nút Create a Free Website. Trong cửa sổ Sign up for Microsoft Office Live 

Small Business, bạn cần điền đầy đủ  những thông tin có chứa dấu „*‟: nhập vào địa chỉ email tại ô Your 

e-mail address rồi nhấn Next (e-mail của gmail hoặc yahoo cũng được); nhập mật khẩu ít nhất 6 kí tự vào 

hai ô Type password và Retype password; chọn tỉnh (thành phố, tiểu bang) tại State/Province; nhập số bưu 

chính tại Zip/Postal Code (phải chính sát, chẳng hạn như bang New York có số này là 10001); chọn câu 

hỏi bảo mật Secret question  và trả lời ít nhất năm kí tự tại Secret answer rồi nhấn Save and continue. Kế 

đến, bạn cần điền một số thông tin về bạn tại mục Enter your information gồm có: First name-tên, Last 

name-họ, Organization name-tên tổ chức, Type of organization -loại hình tổ chức rồi nhấn Save and 

continue. Tiếp tục, bạn hãy nhập mã an toàn gồm tám kí tự tại ô Characters của mục Match the 

characters in the picture rồi nhấn Save and continue  và để hoàn tất quá trình đăng ký bạn nhấn I accept. 

Ở cửa sổ cuối cùng của quá trình đăng ký, bạn sẽ được thông báo yêu cầu đăng nhập vào hộp thư e-mail 

để kích hoạt tài khoản, đồng thời tại đây cũng cho biết về địa chỉ trang Web của bạn tạo được ở góc phải 

phía trên cửa sổ. 

http://www.officelive.com/
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            Sau khi vào hộp thư email và kích hoạt tài khoản, bạn sẽ được truy cập vào tài khoản do Office 

Live cung cấp cùng với những công cụ để bắt đầu thiết kế Website, nhấn Design your site tại khung Get 

Started. 

 

2) Thiết kế trang Web: 

 

            Tại khung Page Manager để tiện cho việc thiết kế bạn chọn Design Site>Design site trên thanh 

công cụ (hoặc chọn Edit ở một trang bất kì được liệt kê bên dưới). Trong cửa sổ Microsoft Office Live 

Small Business Web Design Tool, bạn sẽ thấy một cửa sổ làm việc tương tự như Microsoft Office 2007 

nhưng chỉ gồm có hai thẻ Page Editor và Site Designer. Bây giờ, bạn đừng vội bắt tay vào việc thiết kế 

nội dung cho các trang mà hãy xây dựng một hệ thống các menu chính (cũng như menu thả xuống) và 

giao diện sao cho thật sự khoa học, định hướng tốt cho người xem. 

 

-Tạo hệ thống menu cho Web:       

 

            Bạn phải tạo ra các menu chính trước tiên (tương ứng với mỗi menu là một trang), theo mặc định 

thì Office Live sẽ cung cấp bốn menu chính About US, Contact US, Home, Site map. Bạn có thể chỉnh sửa 

các menu này lại theo ý định của mình bằng cách nhấn vào menu đó rồi chọn thẻ Page Editor> chọn mục 

Advanced > chọn Page properties. Trong cửa sổ Choose page properties, bạn nhập tiêu đề trang tại ô 

Page title cũng như tiêu đề của nó trong bảng điều hướng (Navigation) ở ô Navigation title, rồi nhấn OK. 

Việc làm này cũng thực hiện tương tự như các menu khác. Để thêm vào một trang mới, bạn chọn Web 

pages > chọn New page , rồi kế đến chọn một trong các mẫu chuẩn mà Office Live cung cấp ở khung 

Standard Tamplates và nhấn Next. Trong khung Page Information, bạn điền vào tên trang mới (Page 

title), địa chỉ Web tới trang này (Web address), rồi nhấn Finish. 

            Khi đã tạo đầy đủ các trang, bạn cần sắp xếp và phân loại chúng lại thành menu chính hoặc menu 

thả xuống tương ứng. Vào thẻ Page Eidtor> chọn mục Advanced> chọn Navigation, bạn chọn tên menu 

(tên trang) ở khung Select the page you want to move: nếu tạo ra trang thứ cấp (menu thả xuống) nằm sau 

trang chính (menu chính) thì nhấn chọn tên trang chính ở ô Place page under ; nếu muốn di chuyển thứ tự 

các trang (kể cả trang chính và trang thứ cấp) thì nhấn Move down (hoặc Move up), nhấn OK. 
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-Tạo giao diện Web phù hợp và bắt mắt: 

 

            Việc tạo một giao diện Web đẹp và phù hợp với người xem là một điều quan trọng thể hiện tính 

chuyên nghiệp của Website. Do đó, nếu bạn đã xác định mình làm Website này về lĩnh vực gì thì hãy vào 

thẻ Site Designer để làm cho mình một giao diện Web theo chủ đề đó để lôi cuốn người xem. 

            +Personalize: Mục này cho phép đặt tiêu đề (Site Title) và khẩu hiệu (Site Slogan) của trang tại 

Header, nhập những thông tin sở hữu Web ở ô Footer text đối với Footer, chèn logo của bạn lên đầu trang 

tại Logo. 

            +Design Options: Bạn chọn lĩnh vực mà Web hướng đến tại Theme, mẫu trang Web chỉ thay đổi 

đối với Header tại Style, phối màu tại Color, font chữ tại Font. 

            +Advanced: Một số thiết lập về trang Web: độ rộng (Page Width), canh chỉnh (Page Alignment) và 

nếu không muốn hiển thị ô Display Windows Search (ô tìm kiếm phía trên), „Power by Microsoft Office 

Live‟ (cụm từ của Microsoft ở phía dưới bên trái) thì bạn bỏ dấu kiểm ở hai ô bên dưới mục Display 

Options. 

 

-Xây dựng nội dung cho Web: 

 

            Đến với thẻ Page Editor, việc soạn thảo nội dung cho Website khá dễ dàng với các công cụ liên 

quan đến font chữ (Font); đoạn văn (Paragraph); chèn bảng, hình ảnh, các liên kết, trình diễn 

ảnh,…(Insert). Đặc biệt, ở mục Insert có tính năng Module> HTML giúp cho những bạn thành thạo về 

ngôn ngữ này có thể chỉnh sửa, thêm bớt những đoạn code nhằm tăng hiệu ứng đẹp cho Web. 

            Sau khi thiết kế xong, bạn hãy nhấn nút View  để xem lại thành quả của mình và nhấn nút Save để 

lưu lại. Bây giờ, bạn có thể thỏa thích giới thiệu với bạn bè, người thân,… về trang Web của riêng mình. 
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8 ĐIỀU CẦN LÀM ĐỂ PHÒNG TRÁNH MẤT MÁT DỮ LIỆU  

 

 
Phòng bệnh hơn chữa bệnh. Đừng bao giờ để máy tính của bạn mất 

hết dữ liệu rồi mới tìm cách phục hồi. Bạn nên làm theo 8 điều sau 

đây để chắc chắn rằng: dù có sự cố nào xảy ra, dữ liệu của bạn vẫn 

không bị mất mát. 

1. Sao lưu mọi dữ liệu quan trọng: Bạn nên tập thói quen thường 

xuyên sao lưu các dữ liệu quan trọng bằng nhiều thiết bị lưu trữ khác nhau như: chép ra DVD, ổ cứng di 

động, upload lên cách host trên mạng. 

 Việc sao lưu này có thể thực hiện bằng nhiều trình sao lưu khác nhau. Trong đó Ghost là một phần mềm 

khá ưu việt và dễ sử dụng. Bạn dễ dàng tìm thấy phần mềm Ghost trên đĩa CD tại các cửa hàng dịch vụ tin 

học. 

  

 2. Cài đặt sẵn các chương trình chống virus: Một số virus sẽ tự động xóa các dữ liệu trên máy bạn 

như: văn bản, e-mail… bạn nên cài sẵn một chương trình chống virus để phòng tránh các trường hợp này. 

  

 3. Dùng các thiết bị ổn áp, dụng cụ chống sét, UPS: Sự bất ổn về điện áp thường làm hư hỏng hệ thống 

và gây mất mát dữ liệu. Bạn nên tập làm quen với các thiết bị này, nhất là khi bạn ở Việt Nam. 

  

 4. Không mua hoặc gắn các thiết bị lạ vào máy nếu không có kinh nghiệm: Đôi khi việc gắn các thiết 

bị lạ vào máy có thể gây xung khắc về mặt phần cứng của hệ thống và dĩ nhiên, làm hỏng ổ cứng có chứa 

dữ liệu của bạn. 

  

 5. Thoát khỏi các chương trình trước khi tắt máy: Nên thực hiện điều này vì đôi khi, các chương trình 

chưa kịp sao lưu dữ liệu thì máy đã tắt. Dữ liệu sẽ bị hư hỏng và có thể sẽ không phục hồi lại được. 

  

 6. Không nên tháo, lắp ổ cứng thường xuyên: Khi tháo ổ cứng ra khỏi máy không nên lắc, gỡ hoặc làm 

rớt nó: thói tò mò thường làm hỏng việc, dù ổ cứng của bạn có được quảng cáo là siêu bền đi nữa, nó vẫn 

rất dễ hư về mặt vật lý. 

  

 7. Cẩn thận với các chương trình sửa chữa đĩa cứng: Dù có làm tốc độ truy xuất ổ cứng nhanh hơn, 

các chương trình sửa chữa ổ cứng thường phân tích và sắp xếp lại các bảng hệ thống dữ liệu. Điều này đôi 

lúc cũng làm mất dữ liệu của bạn. Trước khi dùng các phần mềm này, hãy chắc rằng các dữ liệu của bạn 

đã được sao lưu. 

  

 8. Bảo vệ an toàn cho máy tính của bạn: Bảo vệ máy tính cũng là bảo vệ dữ liệu. Hãy đảm bảo máy 

tính của bạn an toàn trước sự va đập, vô nước và các kẻ trộm. 

Theo Mediazone 

 

Tô điểm website được thiết kế bằng Google Sites  

 
Việc thiết kế Website trực tuyến tại Google Sites là một việc khá đơn giản. Tuy nhiên, chính việc đơn 

giản này đã làm cho Websites của thầy (cô) tạo ra “quá tĩnh” mà không có một chút gì thu hút người xem 

(mặc dù quý thầy (cô) đã làm tốt về nội dung). Do đó, thầy (cô) cần phải tô điểm thêm trang web của 

mình bằng một số tiện ích như: bộ đếm web, hiệu ứng động cho web và một vài tiện ích vui khác. 

1)     Tạo bộ đếm cho Website: 

http://www.mediazone.vn/home/thuthuat/168-th-thut.html
http://www.mediazone.vn/home/thuthuat/168-th-thut.html
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            Để biết số lượng người truy cập vào trang web, thầy (cô) cần phải tạo ra một bộ đếm đặt ở trang 

chủ. Có rất nhiều dịch vụ trực tuyến hỗ trợ tạo bộ đếm nhưng phải kể đến trang web tạo bộ đếm đơn giản 

nhất và phù hợp với Google sites là: www.hit-counts.com. Sau khi truy cập vào trang web này, quý thầy 

(cô) thấy hơn 20 mẫu số khác nhau cho thầy (cô) lựa chọn. Kế đến thầy (cô) chọn: số lượng số trong bộ 

đếm (Number of digit), bắt đầu đếm (Initial Count), địa chỉ websites (Site Url), E-mail (Email). Sau đó, 

quý thầy (cô) đánh dấu kiểm vào ô Terms and Conditions, rồi nhấn nút Generate Code và copy đoạn mã ở 

cửa sổ kế tiếp. Bây giờ, thầy (cô) đăng nhập vào trang web với tài khoản do Google cung cấp, rồi nhấn 

nút Edit page tại trang chủ và chọn công cụ Edit HTML source (). Trong cửa sổ hiện ra, thầy (cô) paste 

đoạn code của hit-counts vào bên dưới thẻ HTML và nhấn Update là web của thầy (cô) sẽ có ngay bộ 

đếm. 

 

  
 

2) Nhúng hiệu ứng Flash vào Website: 

 

            Google Sites cho phép thầy (cô) chỉnh sửa mã nguồn của trang web bằng công cụ HTML ( ) 

nhưng chỉ trong một giới hạn nhất định, tức là không cho phép nhúng vào mã nguồn đó các đối tượng: 

frame, embed, styles, script. Điều này đồng nghĩa với việc không nhúng Flash trực tiếp bằng công cụ 

HTML được mà phải nhờ vào tiện ích Include gadget (iframe). 

            Trước khi sử dụng tiện ích Include gadget, thầy (cô) cần phải Upload tập tin Flash cần nhúng lên 

web bằng tính năng Attachments (hoặc tạo một trang mới với dạng trang File Cabinet). Kế đến, nhấn 

chuột phải vào tập tin mới vừa upload và chọn Properties rồi copy địa chỉ tại mục Address (URL). Xong, 

thầy (cô) nhấn Edit page và chọn Insert> More trong cửa sổ chỉnh sửa trang web. Ở cửa sổ Add a gadget 

to your page, thầy (cô) chọn thẻ Featured và chờ trong giây lát, sau đó thầy (cô) kéo thanh trượt ở bên 

phải xuống và tìm đến tiện ích Include gadget (iframe), nhấn Add. Sau đó, thầy (cô) paste (địa chỉ của tập 

tin flash đã upload) vào ô URL to content và chọn các kích thước hiển thị cho tập tin flash trên web ở mục 

Display (Width, Height), nhấn OK rồi nhấn Save ở cửa sổ chỉnh sửa. 

 

http://www.hit-counts.com/
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3) Chèn một vài tiện ích vui khác. 

 

            Trong cửa sổ Add a gadget to your page có rất nhiều tiện ích khác để tô điểm cho trang web của 

thầy (cô) như Google Calendar, Google NewsShow, Clock & Date, Weather, Google Clock, Fish, 

…Chẳng hạn, để chèn tiện ích Fish vào trang web, sau khi nhấn Add thầy (cô) hãy chọn màu nền 
(Background Color), số lượng cá (Number of Fish), màu của từng con cá (Fish 1 Color, Fish 2 Color,…) 

và chọn kích thước hiển thị (Display), rồi nhấn OK là thầy (cô) có ngay một đàn cá trên trang Web của 

mình (thầy (cô) có thể nhấn chuột để cho cá ăn). 

 

 
 

BÙI THANH LIÊM 
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TẠO WEB MIỄN PHÍ VÀ DỄ DÀNG BẰNG GOOGLE SITES  
 

 
  

Việc thiết kế một trang web là một công việc mà mọi người dùng Internet hiện nay đều muốn thực hiện. 

Tuy nhiên, không phải người nào cũng có điều kiện trải qua các khóa học lập trình web nên công việc ấy 

tưởng chừng “vô vọng” đối với những bạn không chuyên. Nhưng hiện nay có thể nói việc thiết kế website 

là một việc làm khá dễ dàng đối với họ vì đã có Google cung cấp một dịch vụ miễn phí. Google Sites sẽ 

giúp cho các bạn sinh viên, các tập thể và thậm chí là các trẻ em nhanh chóng tạo lập một trang web riêng 

cho mình với những hình ảnh, bài viết khá phong phú. Bây giờ, bạn có thể bắt tay vào việc thiết kế web 

với Google Sites: 

 

1) Đăng kí trang Web: 

 

                Đầu tiên, bạn hãy nhập thanh Address: http://sites.google.com . Kế đến bạn cần nhập vào địa chỉ 

email và mật khẩu, nếu bạn chưa có địa chỉ email của google thì bạn hãy đăng kí tại     

http://mail.google.com  (quá trình đăng kí đơn giản và miễn phí), rồi nhấn nút Create site ở cửa sổ kế tiếp. 

Trong cửa sổ Create new site, bạn cần điền đầy đủ các thông tin: tên trang web (Site name), mô tả ngắn về 

trang web (Site description); trang web chỉ dành cho người trưởng thành (Mature content); chọn giao diện 

cho web (Site theme), có thể nhấn More themes để tìm thấy các giao diện khác; nhập mã số hiển thị 

(Please type the code shown), cuối cùng nhấn nút Create site để bước vào việc thiết kế trang chủ. 

 

2) Thiết kế Web: 

 

            Sau khi đăng kí tài khoản xong, bạn sẽ bước vào giao diện thiết kế sẽ thấy các công cụ cho việc 

xây dựng trang web. 

            *Bước 1:Ở trang đầu tiên, bạn nhấn nút Edit page để thiết kế trang chủ. Công cụ này có cửa sổ 

giống như Word nên rất thuận lợi cho bạn, gồm có các tính năng như Insert (chèn hình ảnh, link, liên kết 

với các dịch vụ khác của Google: Google Document; Google Video;….và YouTube), Format (gõ chỉ số 

trên, dưới, canh lề,…), Table (chèn bảng), Layout (bố trí trang web thành 01 hoặc 02 cột). Đặc biệt, tính 

năng HTML sẽ giúp cho các bạn “rành” về ngôn ngữ này có thể dễ dàng kiểm tra, chỉnh sửa, thêm bớt các 

hiệu ứng cho web mà Google Sites không cung cấp sẵn. 

  

 
Sau khi đã hoàn thành xong nội dung, bạn hãy nhấn nút Save để lưu lại. 

            *Bước 2: Kế tiếp, bạn cần bổ xung thêm hình nền, logo, chỉnh sửa thanh Sidebar,… bằng tính 

năng Change appearance (Site settings>Change appearance). Trong cửa sổ hiện ra, bạn sẽ thấy các thẻ 

chính của tính năng Appearance này: Site Elements, Colors and Fonts, Themes 

+Site Elements: 

            -Header: bạn nhấn nút Change logo để thay đổi logo cho trang web của mình. Trong cửa sổ 

Configure site logo, bạn hãy chọn Custom logo và nhấn nút Browse để duyệt đến logo cần chèn trên máy 

hoặc có thể không chọn logo tại No logo. 

            -Sidebar: theo mặc định thì Google sites sẽ cung cấp hai thanh: Navigation (Các mục chính) và 

Recent site activity (những hoạt động gần đây nhất của web). Ngoài ra, bạn có thể nhấn Add a sidebar 

item để có thể tăng thêm các thanh khác như: Text, My recent activity, Countdown. Nếu muốn chỉnh sửa 

một sidebar nào thì chỉ việc nhấn Edit, chẳng hạn như đối với mục Navigation bạn có thể thêm vào các 

http://sites.google.com/
http://mail.google.com/
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mục (liên kết đến các trang khác) bằng cách nhấn Add page to sidebar navigation, hoặc có thể xóa chúng 

(Delete). 

+Colors and Fonts: Thẻ này sẽ giúp bạn thay đổi màu, hình nền cho web, tiêu đề (Header), từng trang 

(Page), Sidebar. Đối với việc chèn hình nền cho đối tượng thì cần nhấn Browse để duyệt đến bức ảnh và 

cần chờ một khoảng thời gian để Upload lên máy chủ. 

+Themes: Nếu cảm thấy không vừa lòng với giao diện web đã chọn ban đầu lúc đăng kí tài khoản thì có 

thể chọn lại tại đây (gồm có 24 themes). 

            Sau mỗi thay đổi, bạn cần nhấn Save changes để lưu lại trước khi quay trở ra trang web (Return to 

site). 

            *Bước 3: Sau khi đã thiết kế trang đầu tiên, bạn cần phải tạo ra các trang thứ 2, 3,… Để thực hiện 

việc này, bạn nhấn nút Create new page rồi chọn một trong 5 dạng: Web page, Dashboard, 

Announcements, File Cabinet, List, rồi đặt tên cho trang mới (Name) và chọn nơi đặt trang: đặt ở đầu 

trang (Put page at the top level), đặt bên dưới trang chủ (Put page under “tên trang chủ”). Cuối cùng 

nhấn Create page để tạo ra trang mới và mọi công việc thiết kế cũng sẽ sử dụng các tính năng nêu trên. 

  
 

  *Bước 4: Sau khi thiết kế hoàn chỉnh trang web thì bạn có thể chia sẽ ngay cho bạn bè và mọi người. 

Bạn nhấn Site settings> rồi chọn Share this site, sẽ được lựa chọn một trong ba dạng Owners (có quyền 

như bạn, tức là có thể xem, chia sẽ và chỉnh sửa thông tin, thậm chí xóa cả trang Web), Collaborators (có 

quyền cộng tác, tức là có thể chỉnh sửa nội dung Web nhưng không thể thay đổi các thông tin quản trị 

khác), Viewers (chỉ được xem). Sau đó, bạn hãy nhập vào địa chỉ email vào ô bên dưới, rồi nhấn Invite 

these people và nhấn send ở cửa sổ kế tiếp. Lưu ý, bạn đừng quên đánh dấu kiểm vào mục Anyone in the 

world may view this site (make it public) để mọi người trên thế giới có thể vào Website của bạn.  

            3) Một số lưu ý: 

            -Bạn dễ dàng xem dung lượng sử dụng mà Google Sites cung cấp cho web của bạn (tối đa là 

100MB) tại thẻ Site settings> chọn Other stuff và xem tại bảng Site stogare. 

            -Có thể kết hợp Google Sites với các dịch vụ khác của  Google: Document, Calendar, Picasa Web, 

Presentation, Video…vào trang web. 

            -Khi bạn không hài lòng với trang web do mình thiết kế thì có thể xóa vĩnh viễn nó (không thể 

phục hồi được kể cả bạn). Bạn vào mục Other Stuff  rồi nhấn Delete this Site (cạnh dòng chữ cảnh báo 

màu đỏ ở cuối trang). Lưu ý, mục này có thể bị các kẻ xấu lợi dụng để xóa trang web của bạn nên lúc chia 

sẽ Website cần quan tâm dạng Owners, chỉ gửi cho những người bạn thân hay tốt nhất là không chọn dạng 

này. 

            -Bạn có thể tham khảo một trang web do người viết bài này tạo, tại địa chỉ: 

http://sites.google.com/site/thanhliem24/ 

http://sites.google.com/site/thanhliem24/
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NHỮNG THỦ THUẬT VĂN PHÒNG  
   

Thủ thuật Word: 
-Trích xuất ảnh trong Word nhanh chóng không cần phần mềm: bạn thực hiện bằng cách mở file Word 

cần trích xuất ảnh, chọn File>Save As, ở mục Save as type (cạnh ô File names), chọn Web Pages, 

Filtered, sau đó bạn lưu vào thư mục nào đó và vào thư mục đó sẽ thấy ngay kết quả. 

-Thay thế từ và cụm từ nhanh chóng bằng lệnh Ctrl+F (hoặc Edit>Find), bạn nhập cụm từ vào ô Find 

What và cụm từ thay thế vào ô Replace with, sau đó nhấn Replace hoặc Replace All các cụm từ sẽ được 

thay thế nhanh chóng không cần vất vả nhập lại. 

  

 
 

  -Tạo password bảo vệ nội dung văn bản:vào menu Tools>Protect Document, rồi chọn các mức độ bảo vệ 

nhưng vẫn xem được nội dung, nếu muốn người khác không xem được nội dung bên trong bạn hãy vào 

Tools>Options, rồi chọn thẻ Security rồi nhập mật khẩu vào ô Password to open, rồi nhấn OK và nhập lại 

mật khẩu một lần nữa, cuối cùng nhấn nút Save để lưu thuộc tính.  

  

Thủ thuật Excel 
- Tự động đổi màu ô của sheet Excel khi ô đó có giá trị: 

Đầu tiên, bạn hãy mở Excel và chọn cho mình một ô (chẳng hạn D103), rồi chọn Format > Conditional 

Formatting, cửa sổ Conditional Formatting hiện ra, chọn Formula Is và ghi vào nội dung hàm theo ý bạn, 

rồi bấm vào nút Format cửa sổ Format Cells hiện ra bạn hãy chọn thẻ Patterns chọn màu, bấm OK (ở đây 

tôi ghi vào hàm =D$103=0, chọn màu vàng ở Patterns việc này có nghĩa là ô sẽ hiện màu vàng khi ô 
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D103 này không có giá trị; bạn có thể làm ngược lại bằng cách ghi lại hàm =D$103<>0), cuối cùng bấm 

OK để hoàn tất, bạn có thể đánh một chữ nào đó vào ô này để xem kết quả. 

 

 
 

-Giấu tên (Tabs) các sheet và thanh cột, dòng: bạn có thể làm biến mất các chủ đề này bằng cách vào 

menu Tools>Options, cửa sổ Options hiện ra bạn hãy chọn thẻ View, ở mục Windows Options bạn hãy bỏ 

dấu kiểm ở hai ô Row & column headers và Sheets Tabs, rồi bấm OK. 

-Cố định dòng và cột trong sheet Excel: bạn chỉ cần để chuột vào ô lân cận với dòng và cột muốn cố định 

và vào menu Window>Freeze Panes. 

  

BÙI THANH LIÊM 
  

Photoline: phần mềm xử lý ảnh cho ngày Tết 

TTO - PhotoLine là một trong số ít những phần mềm biên tập, xử lý ảnh không đòi hỏi cao về cấu hình 

máy tính, bạn dễ dàng sử dụng ứng dụng này trên các dòng máy “có tuổi”.  

Tuy số lượng các tính năng không bằng các phần mềm đồ họa danh tiếng như Photoshop nhưng 

PhotoLine có thể đáp ứng đầy đủ các nhu cầu xử lý ảnh thông thường của người dùng phổ thông. Phần 

mềm PhotoLine 15.5 có dung lượng 17,4MB, bạn có thể tải bản dùng thử tại đây.  

Giao diện 

 

 

 

PhotoLine có giao diện rất thân thiện với cửa sổ chính chứa các đối tượng: thanh menu, thanh công cụ 

nằm ngang (bên dưới thanh menu), thanh công cụ thẳng đứng ở bên trái, các thanh thông tin ở bên phải.  

http://www.pl32.com/pages/down.php
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-Thanh menu: Ở menu View, bạn có thể làm ẩn hoặc hiển thị các thanh công cụ: Toolbox-thanh công cụ 

cơ bản ở bên trái, General-thanh công cụ chuẩn, Color Select Field-bảng màu, Contrast/Brightness-tăng 

hoặc giảm độ tương phản, Zoom-phóng to hay thu nhỏ, Alignment-canh chỉnh đối tượng, Gallery-thư viện 

hiệu ứng, Histogram-biểu đồ tần xuất, Attributes-thuộc tính liên quan đến bức ảnh, …bằng cách chọn 

trong các danh mục Toolbars và Dialogs. 

Ở phía bên phải giao diện là các khung chứa các công cụ: Tool Settings- các công cụ chi tiết của mỗi công 

cụ trên thanh Toolbox, Picture info-thông tin về hình ảnh, Views-các dạng hiển thị hình ảnh, 

Layers/Channels-quản lí các layer và chuẩn màu…  

Những tính năng cơ bản 

PhotoLine có rất nhiều tính năng đồ họa chuyên nghiệp nhưng phần lớn tập trung vào hai menu Filter và 

Effects, trong đó phải kể đến tính năng đã làm nên thế mạnh của ứng dụng là các bộ lọc (Filter). Số lượng 

các bộ lọc trên menu Filter khá phong phú: Automatic-giúp cho người mới học dễ dàng hơn trong việc 

nâng cao chất lượng hình ảnh, Sharpen-làm sắc nét các đường, Blur-tạo các hiệu ứng bóng mờ, Quality-

tăng cường chất lượng cho ảnh bằng cách tối ưu độ sáng, Digital Camera-giúp chỉnh sửa ảnh số, Stylize-

biến bức ảnh thành các dạng ảnh hội họa, điêu khắc, … 

 

 

Các công cụ trên thanh Toolbox 

 

PhotoLine cung cấp nhiều công cụ đồ họa giúp bạn xử lý ảnh theo các lớp. Các công cụ trên thanh này 

gồm có: Layer Tool-biểu tượng trỏ chuột, giúp bạn lựa chọn đối tượng để tiện cho việc sao chép, cắt, xóa 

và di chuyển; Circle/Ellipse-vẽ hình tròn hay elip; Text Tool-biểu tượng chữ T, công cụ hỗ trợ nhập văn 

bản vào hình ảnh; Vector Drawing-vẽ các dạng đường thẳng, đường cong; Crop- cắt xén ảnh; Color 

Picker-lấy mẫu màu trên đối tượng; Painting-nhóm công cụ gồm các loại bút vẽ; Eraser-xóa những nơi 

không cần thiết... bạn có thể tự khám phá thêm. 

Lưu ý: nếu bên dưới các công cụ có dấu tam giác nhỏ màu đỏ thì bạn hãy nhấn giữ chuột trái để chọn 

công cụ khác trong nhóm đó. 

 

Làm việc với thư viện hiệu ứng (Gallery) 
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Để mở danh sách hiệu ứng, bạn vào menu View > chọn Dialogs > chọn Gallery. Trong cửa sổ hiện ra, 

bạn chọn một hiệu ứng trong các chủ đề: New, Document, Frame, Buttons, Text, Dyn-Effects, Image 

Tools, Image Effects 2D, Image Effects 3D, Toolbar, rồi nhấn vào nút Apply gallery entry (biểu tượng tam 

giác) để áp dụng hiệu ứng đó lên bức ảnh của mình.  

Nếu không vừa ý với các hiệu ứng mặc định của chương trình thì bạn có thể chỉnh sửa mẫu hiệu ứng bằng 

cách nhấn vào nút Edit gallery entry sau khi chọn mẫu. Chẳng hạn, đối với mẫu Heart của chủ đề Image 

Effect 3D, bạn kéo thanh trượt trong khung Background để tăng hay giảm độ sậm màu của ảnh nền, kéo 

thanh trượt Foreground để tăng hay giảm kích thước ảnh nổi hình trái tim phía trước và có thể thay hình 

trái tim thành một hình dạng yêu thích ở mục Shape. Các tên gọi của một số mẫu rất khó nhớ, bạn nhấn 

vào nút Rename gallery entry (biểu tượng A-B) để đặt lại tên cho mẫu. 

Ngoài các hiệu ứng được cung cấp thì trên menu Effects còn rất nhiều hiệu ứng khác: Mosaic-hiệu ứng 

ảnh được tạo từ nhiều mảnh ghép nhỏ, Clouds-tạo hiệu ứng đám mây mù, Perturbation-tạo hiệu ứng ảnh 

mờ dạng nhiễu, Perspective Tiling-nhân bản ảnh dạng ghép nhiều ô vuông, Beautify-tạo hiệu ứng mềm 

mại cho ảnh, Swirl-hiệu ứng xoáy nước, … 

 

Tạo khung ảnh 

 

Ngoài các mẫu khung ảnh được cung cấp trong Gallery, bạn còn có thể tùy chỉnh từng dạng mẫu ở menu 

Effects > Frame. Tại cửa sổ Frame, bạn chọn một mẫu trong ô Preset rồi quan sát hình ảnh minh họa 

trong khung bên phải.  

Trong khung ở bên trái, bạn nhấn vào Frame Outside rồi thay đổi các đối tượng: Outer-hình dạng khung 

phía ngoài, Color-màu đường viền, Line Style-kiểu đường viền, sao cho phù hợp. Cũng làm tương tự như 

trên ở mục Frame Inside nhưng bạn có thể kéo thanh trượt bên dưới chữ Width để tăng hay giảm độ rộng 

của khung. Còn mục Shadow giúp tạo ra hiệu ứng bóng mờ cho khung, bạn thay đổi góc chiếu bóng mờ, 

màu sắc, kiểu đổ bóng ở hai mục thành phần là General và Color. 
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BÙI THANH LIÊM 

 

Norton Online Backup: 5 GB lưu trữ dữ liệu trực tuyến 

miễn phí  
 

Thứ ba, 15/06/2010, 09:06 GMT+7 

 
 

Với một đường truyền ADSL ổn định, bạn có thể tạo một bản sao lưu dự phòng cho những dữ liệu 
quan trọng của mình bằng các dịch vụ sao lưu trực tuyến. Điểm mạnh của các dịch vụ là giúp phục hồi dữ 
liệu bất kỳ lúc nào và bất cứ nơi đâu, miễn là có Internet, có thể chia sẻ dữ liệu với nhiều người, không sợ 
các trường hợp đánh mất như đang lưu trữ trên các thiết bị di động, vv... Nổi lên trong số ấy là dịch vụ 
Norton Online Backup vì với một tài khoản miễn phí, bạn sẽ sở hữu 5 GB để lưu trữ dữ liệu trực tuyến. 

 

 
1. Đăng ký sử dụng dịch vụ 

 
Đầu tiên, bạn truy cập vào địa chỉ https://nobu.backup.com rồi bấm vào chữ Sign up now bên dưới dòng chữ 

Don’t have an account. Ở trang mới hiện ra, bạn bấm vào chữ Try để trải nghiệm những tính năng của dịch vụ 
trong thời gian 30 ngày, trước khi quyết định trả phí sử dụng. Trong khung Sign up for Norton Online Backup, bạn 
cần khai báo những thông tin: Country/Region - quốc gia/vùng lãnh thổ, Email Address - địa chỉ thư điện tử, 
Password - mật khẩu, Retype password - nhập lại mật khẩu, và đánh dấu kiểm vào hai ô I have read and agree to 
the Terms of Service (đồng ý với các điều khoản), Email me product updates, offers, and security newsletters (cập 
nhật thông tin sản phẩm, bảo mật qua email), rồi bấm Sign Up.  
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Kế đến, bạn bấm vào nút Download để tải về phần mềm Norton Online Backup (hoặc có thể tải tại: 
http://tinyurl.com/noronba). Phần mềm này tương thích với các hệ điều hành Windows XP/Vista/7 và Mac OS X. 
Sau khi cài đặt, phần mềm sẽ chạy thường trú ở khay hệ thống và cửa sổ trình duyệt sẽ mở ra, bấm nút Done. 

 
2. Khai thác tính năng của dịch vụ 

 
Cửa sổ dịch vụ Norton Online Backup có các tính năng được bố trí khá đơn giản. Nếu đang sử dụng nhiều 

máy tính thì bạn bấm Add a Computer để thêm vào danh sách, rồi đánh dấu kiểm I have read and agree to the 
Terms of Service và cài đặt phần mềm cho các máy đó. Ngược lại, bạn bấm Remove a Computer và bấm Remove 
để gỡ bỏ máy tính đó ra khỏi danh sách cần sao lưu.  

- Sao lưu dữ liệu 
Trước khi tiến hành sao lưu dữ liệu, bạn bấm nút Settings ở máy tính tương ứng để đưa ra một số thiết lập cần 

thiết. Bạn chọn thẻ What (mặc định là thẻ Summary), ngoài thư mục C:\Documents and Settings (C:\ là ổ đĩa chứa 
hệ điều hành) thì có thể bấm Add more sources để chọn thêm thư mục cần sao lưu khác. Ở khung File Categories, 
bạn chọn ra các định dạng tập tin muốn sao lưu, chẳng hạn như Office Docs (các định dạng văn bản, bảng tính, 
trình diễn), Email (các định dạng thư điện tử của một số chương trình), Pictures (các định dạng ảnh thông dụng, 
định dạng vectơ), Music (hầu hết các định dạng âm thanh), Video (các định dạng video thông dụng, có cả dạng 
flash), Internet Favorites (chủ yếu là địa chỉ url). Khi chọn các định dạng này thì trong quá trình sao lưu, dịch vụ sẽ 
tìm và sao lưu tất cả các tập tin ấy. Bên cạnh đó, bạn có thể đưa vào danh sách cần sao lưu những tập tin và thư 
mục quan trọng bằng cách bấm Add Files hoặc Add Folders.  

Ngoài ra, bạn có thể lên lịch trình cho việc sao lưu ở thẻ When. Mặc định, dấu chọn nằm ở mục Scheduled, 
bạn cần chọn thêm thời điểm: Automatic (recommended) - sao lưu vào thời điểm ngẫu nhiên trong ngày, Daily - 
sao lưu tập tin hàng ngày vào một khung thời gian cụ thể, Weekly - cho phép sao lưu vào một ngày nào đó trong 
tuần, Monthly - sao lưu vào một ngày định trước trong tháng. Ở 3 tùy chọn bên dưới sẽ làm xuất hiện hai khung 
Which Day và Starting At. Khung Starting At giúp quy định khung thời gian, bạn chọn một trong bốn ở ô bên dưới 
Approximate Start Time và chọn giờ khu vực ở Time Zone for this computer. Bây giờ, bạn bấm nút Save rồi bấm 
nút Back Up Now ở cửa sổ chính của Norton Online Backup (hoặc bấm chuột phải vào biểu tượng ở khay hệ thống 
chọn Backup now) để bắt đầu tiến trình sao lưu. 

- Phục hồi dữ liệu 
Khi cần phục hồi dữ liệu, bạn bấm chuột phải vào biểu tượng của chương trình rồi chọn Home (hoặc truy cập 

vào trang https://nobu. backup.com) và đăng nhập vào tài khoản của mình. Ở cửa sổ chính, bạn bấm nút File 
Actions rồi chọn Restore Files ở danh sách tính năng xổ xuống. Trang tiếp theo hiện ra, bạn duyệt đến thư mục 
cần phục hồi ở cây thư mục cột Folders, chọn những tập tin ở cột Files - có thể bấm Select All để chọn tất cả. Mặt 
khác, bạn bấm Show Options ở khung Options để lựa chọn một số thiết lập cần thiết. Nếu các máy tính có thư 
mục, tập tin giống nhau thì bạn chọn tên máy ở ô To để phục hồi cho từng máy. Riêng ở Folder Options, bạn đánh 
dấu chọn Place Files in the “Restored Files” folder on your desktop (tạo thư mục Restored Files trên desktop, rồi tải 
các tập tin vào đó) hoặc Restore Files to their original location on your computer (tải các tập tin đã sao lưu vào 
đúng thư mục gốc), chọn thêm Overwrite existing files để ghi đè lên các tập tin trùng tên. Khi xong, bạn bấm nút 
Restore now để phục hồi.  

- Xóa tập tin, thư mục đã sao lưu 
Tính năng Purge Files sẽ giúp ích cho việc xóa những tập tin, thư mục không mong muốn trong gói đã sao lưu 

ban đầu, hay giúp giải phóng không gian lưu trữ trực tuyến để nhường chỗ cho các tập tin khác. Bạn cũng thực 
hiện tương tự như tính năng Restore Files nhưng khi xong thì bấm Purge Now. 
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